AVAYA

Avaya Solution & Interoperability Test Lab

Application Notes for Configuring Alestra Enlace IP SIP
Trunk Service (Broadsoft platform) with Avaya IP Office
9.0 using SIP Trunk Registration— Issue 1.0

Abstract

These Application Notes describe the procedures for configuring Session Initiation Protocol
(SIP) Trunking between the Alestra Enlace IP SIP Trunk service on the Broadsoft platform
and Avaya IP Office 9.0, using SIP Trunk Registration.

The Enlace IP SIP Trunk service offered by Alestra provides customers with PSTN access via
a SIP trunk between the enterprise and the Alestra network, as an alternative to legacy analog
or digital trunks. This approach generally results in lower cost for the enterprise.

Information in these Application Notes has been obtained through DevConnect compliance
testing and additional technical discussions. Testing was conducted via the DevConnect
Program at the Avaya Solution and Interoperability Test Lab.
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1. Introduction

These Application Notes describe the procedures for configuring Session Initiation Protocol
(SIP) Trunking between the Alestra Enlace IP SIP Trunk service on the Broadsoft platform and
Avaya IP Office 9.0, using SIP Trunk Registration.

In the sample configuration, the Avaya IP Office solution consists of an Avaya IP Office 500v2
Release 9.0, Avaya Voicemail Pro, Avaya IP Office soft clients and deskphones, including SIP,
H.323, digital, and analog endpoints.

The Alestra Enlace IP SIP Trunk service referenced within these Application Notes is designed
for enterprise business customers in Mexico. Customers using this service with the Avaya SIP-
enabled enterprise solution are able to place and receive PSTN calls via a broadband WAN
connection and the SIP protocol. This converged network solution is an alternative to traditional
PSTN trunks such as analog and/or ISDN-PRI.

2. General Test Approach and Test Results

A simulated enterprise site containing the Avaya IP Office equipment was installed at the Avaya
Solution and Interoperability Lab. The enterprise site was configured to connect to the Alestra
Enlace IP SIP Trunk service via a broadband connection to the public Internet.

The configuration shown in Figure 1 was used to exercise the features and functionality tests
listed in Section 2.1.

DevConnect Compliance Testing is conducted jointly by Avaya and DevConnect members. The
jointly-defined test plan focuses on exercising APIs and/or standards-based interfaces pertinent
to the interoperability of the tested products and their functionalities. DevConnect Compliance
Testing is not intended to substitute full product performance or feature testing performed by
DevConnect members, nor is it to be construed as an endorsement by Avaya of the suitability or
completeness of a DevConnect member’s solution.

Testing was performed with IP Office 500 v2 R9.0, but it also applies to IP Office Server Edition
R9.0. Note that IP Office Server Edition requires an Expansion IP Office 500 v2 R9.0 to support
analog or digital endpoints or trunks.
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2.1. Interoperability Compliance Testing

To verify SIP trunking interoperability, the following features and functionality were covered
during the interoperability compliance test:

Response to SIP OPTIONS queries.

Incoming PSTN calls to various phone types. Phone types included SIP, H.323, digital
and analog telephones at the enterprise. All inbound PSTN calls were routed to the
enterprise across the SIP trunk from the service provider.

Outgoing PSTN calls from various phone types. Phone types included SIP, H.323,
digital, and analog telephones at the enterprise. All outbound PSTN calls were routed
from the enterprise across the SIP trunk to the service provider.

Inbound and outbound PSTN calls to/from Avaya IP Office Softphone.

Inbound and outbound PSTN calls to/from Avaya Flare® Experience for Windows
softphone.

Various call types including: local, long distance, international, outbound toll-free, etc.
Codecs G729A and G.711A.

Fax using T.38 and G711 pass-through methods.

Caller ID presentation and Caller ID restriction.

DTMF transmission using RFC 2833.

Voicemail navigation for inbound and outbound calls.

User features such as hold and resume, transfer, and conference.

Off-net call transfer, call forwarding and twinning.

Items not supported or not tested included the following:

Inbound toll-free and emergency calls are supported but were not tested as part of the
compliance test
Operator services such as dialing 0 or 0 + 10 digits are not supported.
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2.2. Test Results

Interoperability testing of the Alestra Enlace IP SIP trunk service was completed with successful
results for all test cases with the exception of the observations and limitations described below:

Caller ID on incoming calls from the U.S.: Calls originating from PSTN telephones in
the U.S. to DIDs numbers in Mexico assigned to the IP Office SIP trunk displayed a
caller ID “anonymous” on the enterprise extensions. The “From” header on the INVITE
of these incoming calls was “anonymous@anonymous.invalid”. This seems to be a PSTN
restriction for all international inbound calls to Mexico from the U.S., not limited just to
Alestra. This behavior is not necessarily indicative of a limitation of the combined
Alestra/Avaya solution, and it is listed here simply as an observation.

No matching codec on outbound call: On an outbound call containing only one codec in
its SDP offer that was not supported by the service provider, Alestra responded sending
back a “480 Temporarily Unavailable” error code, instead of the expected “488 Not
Acceptable Here”. There is no impact to the user, who hears an error tone.

Caller ID on call forward to the PSTN: On inbound calls that were forwarded back out
to another user on the PSTN, the caller ID number shown on the receiving end was the
DID number assigned to the SIP trunk, not the caller ID of the call originator.

Outbound Calling Party Number (CPN) Block: When an enterprise user activated
“Withhold Number” on an outbound call, IP Office sent “anonymous” in the From
header, included the “Privacy:id” header, and the complete DID number in the
P-Asserted-Identity (PAI) header of the outbound INVITE, as expected. In this scenario,
Alestra returned a “404 Not Found” and calls failed, suggesting that the PAI header is not
inspected for authentication purposes in the Alestra network.

T.38 Fax: Testing of T38 fax while interworking with the G.729A codec for the voice
setup was successful. During testing of the T.38 fax using codec G.711 for the voice
setup, Alestra returned a “488 Not Acceptable Here” error code to the T.38 re-INVITE
from IP Office using SDP with T.38 parameters and the fax calls dropped. Since G729A
voice setup is the normal mode of operation in this solution, this limitation has no real
impact to the user.

Additionally, inbound and outbound fax calls using the G.711 pass-through Fax
Transport Support mode were tested successfully.

Response to OPTIONS: During the compliance test, Alestra responded to OPTIONS
messages sent from the IP Office with a “405 Method Not Allowed” message. Since the
OPTIONS messages were used to check the status of the network connectivity to the
service provider, any response received from Alestra was sufficient to achieve that
purpose.

2.3. Support

For technical support on the Alestra Enlace IP SIP Trunk service offer, visit
http://www.alestra.com.mx/
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3. Reference Configuration

Figure 1 illustrates the sample Avaya SIP-enabled enterprise solution, connected to the Alestra
Enlace IP SIP Trunk service through a public Internet WAN connection.

Alestra Network (Broadsoft Platform)

DID [username) 8123456789
Passwd! password123

SBC 192.168.26.150

%ip domain asbw.alestravoip.com

Internet

Enterprise
3P Router SIP damain: :il.miaml.auaya.nnm

Iﬁ Entarprisa Firavall

VAN Pubic

Awayn 1408, 2508 Avaya izl Avaya 11XX

Digital Tedsphones P Ofcs Manager N ok phones  Telophones  Avaya P Office  Avaya Flarss
Vales Mall Pra ph {H323) (BiP} Senphons Expariance for
[H_323) i

Figure 1: Test Configuration

Note that for security purposes all public IP addresses of the network elements, public PSTN
numbers and SIP trunk credentials shown throughout these Application Notes have been edited
so the actual values are not revealed.
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The enterprise site contains the Avaya IP Office 500v2 with analog and digital extension
expansion modules, as well as a VCM®64 (Voice Compression Module) for supporting VolP
codecs. The LANL1 port of Avaya IP Office is connected to the enterprise LAN while the LAN2
port is connected to the public IP network. Endpoints include Avaya 1600 and 9600 Series IP
Telephones (with H.323 firmware), Avaya 1140E IP Telephones (with SIP firmware), Avaya
1408 and 9508D Digital Telephones, analog telephones and PCs running Avaya IP Office
Softphone and Avaya Flare® Experience for Windows. The site also has a Windows PC running
Avaya IP Office Manager to configure and administer the Avaya IP Office system, and Avaya
Voicemail Pro providing voice messaging service to the Avaya IP Office users. Mobile
Twinning is configured for some of the Avaya IP Office users so that calls to these users’
extensions will also ring and can be answered at the configured mobile phones.

In an actual customer configuration, the enterprise site may include additional network
components between the service provider and the Avaya IP Office system, such as a session
border controller or data firewall. A complete discussion of the configuration of these devices is
beyond the scope of these Application Notes. However, it should be noted that all SIP and RTP
traffic between the service provider and the Avaya IP Office system must be allowed to pass
through these devices.

During the compliance test, in addition to the DID number assigned to the SIP trunk, Alestra
provided a local test number in Monterrey, Mexico. A SIP-based softphone was registered to this
local PSTN number and was used to originate and terminate local calls to and from the PSTN to
the enterprise
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4. Equipment and Software Validated
The following equipment and software were used for the sample configuration provided:

DCPx16

Component | Version

Avaya

Avaya IP Office 500v2 9.0.200.860
Avaya IP Office Digital Expansion Module 9.0.200.860

Avaya IP Office Manager

9.0.2.0.Build 860

Avaya IP Office Voicemail Pro 9.0.2.0.41
Avaya 1608 IP Telephone (H.323) 1.3 SP3
Avaya 9640 IP Telephone (H.323) Avaya one-X Deskphone Edition
3.2
Avaya 1140E IP Telephone (SIP) 04.03.18.00
Avaya Digital Telephone 1408 32.0
Avaya Digital Phone 9508 0.45
Avaya IP Office Softphone 3.2.3.49.68975
Avaya IP Office Flare Experience for Windows 1.1.4.23
Alestra
Broadsoft Softswitch Release 17 SP 4
Acme Packet SBC V6.2
Lucent SESS V16.1

5. Configure IP Office

This section describes the Avaya IP Office configuration necessary to support connectivity to the
Alestra Enlace IP SIP Trunk service. Avaya IP Office is configured through the Avaya IP Office
Manager PC application. From the PC running Avaya IP Office Manager, select Start -
Programs = IP Office & Manager to launch the application. Navigate to File = Open
Configuration (not shown), select the proper Avaya IP Office system from the pop-up window,
and log in with the appropriate credentials. A management window will appear similar to the one
shown in the next section.

The appearance of the IP Office Manager can be customized using the View menu. In the
screens presented in this section, the View menu was configured to show the Navigation pane on
the left side and the Details pane on the right side. These panes will be referenced throughout the
Avaya IP Office configuration.

Standard feature configurations that are not directly related to the interfacing with the service
provider (such as LAN interface to the enterprise site, Twinning and IP Office Softphone
support) are assumed to be already in place, and they are not part of these Application Notes.
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5.1. Licensing

The configuration and features described in these Application Notes require the IP Office system
to be licensed appropriately. If a desired feature is not enabled or there is insufficient capacity,
contact an authorized Avaya sales representative.

To verify that there is a SIP Trunk Channels License with sufficient capacity; click License in
the Navigation pane. Confirm that there is a valid license with sufficient “Instances” (trunk
channels) in the Details pane.

IP Offices

- R BOOTP(3)
“ Operator (3)
IPS00YE Main
) Swskem (1)

=¢ IPS00YZ Main
[ Line (21)
[ Conkrol Unit {4}
[+--4 Extension (47)
£
£
&

H-§  User (48)

]1“ Group (1)

#-- @ Short Code (65)

----- @ Service ()

[Haify RAS (L)

[]---@ Incoming Call Route (&)
----- @ WanPart {00

----- a4 Directory (0)

| Time Profile {0}

-8 Fireweall Profile (1)
-l IP Route (3)

----- g Account Code (0)
License (62)

----- i Tunnel (0}

[]---§ 3 User Rights (8)

- ARS (2)

----- ' RAS Location Request {0}
----- Ha Location (0)

License |Rem0te Server |

pLos Host 1D 11121 [

Feature | License ke I Instances I Status Expiry Date
Unused (1) tEZgHNYNSDp@KFYRG... | 255 Walid Mever
CTI Link Pro EiGcmbEmoly2qCirdkE.,. 255 Yalid Mewver
| | 5P Trunk Charnels ¥nEHEEhADHL42wonZ. .. | 255 Valid Mever |
Grd Party IP Endpoints 41z8hzyWisz_MISzvid,.. | 255 Walid Mever
IPS00 Universal PRI (Additional chan...  1nmDIREQWIpOOULPRI... 255 Walid Mever
1600 Series Phones LgOrJz@4LDf aPoEga_... 255 Walid Mever
Wave Lser BlizsxrB1bA@SUIR:RO,.. 255 Yalid Mewver
Integrated Messaging cbwsSckzLat7hg_Dfno... | 255 Walid Mever
Preferred Edition (Voicemail Pra) @Iinki@i@_Mxenhd7n.,.. 255 Yalid Mever
Microsoft CRM Integration (users) Qlz5fo@xDXzQE9B0H. .. 255 Walid Mever
CCC Spectrum Wallboards BINbIEdjgkYIUE38%HGm. .. | 255 Yalid Mever
Phone Manager Pro 23CTz1vwEPMShlcxTYx... | 255 Walid Mever
Phone Manager Pro IP Audio Enabled...  ®T9Inje2MyUsquxellx... 255 Walid Mever
Compact Business Centre Ma530eokgjyUKCIE1G... 255 Walid Mever
CCC Server @h13H09d R Fwd756,., 255 Yalid Mewver
CCC PC Wallboards ealR_qtPEvwIsQEZBaoc... 255 Walid Mever
CCC Superyisors ZRWxEvElgvjaPeyiy... | 255 Walid Mever
Receptionist ZHONH3tmMEwASpMM, . 255 Walid Mever
eBLF gr@YhTeWwdoyHaxLZK... 255 Walid Mever
Preferred Edition Additional Yoicemail ... ZIuEWYSLLMNYZF2Fclw, ., 255 Walid Mever
AUDLY Voicemail ATQUhZEEdAd@SrEev,.. 255 Walid Mever
WMPro Metworked Messaging bTM30Fd1DvIxvaIAZ.., 255 Yalid Mever
WMPro Dakabase Interface jaSyBMNvEQGDZUIMO. .. 255 Walid Mever
WMPro WE Script dq¥anSynLY7EF7rC4en.., 255 Walid Mever
WMPro Recordings Administrakors AZcsyyBYdOO2dZovRE... 255 Walid Mever

MAA; Reviewed:
SPOC 8/7/2014

Solution & Interoperability Test Lab Application Notes

©2014 Avaya Inc. All Rights Reserved.

8 of 31
Altr_Brsft_IPO9




5.2. LAN2 Settings

In the sample configuration, IP500V2 Main was used as the system name, and the WAN port
was used to connect the Avaya IP Office to the public network. The LAN2 settings correspond to
the WAN port on the Avaya IP Office. To access the LAN2 settings, first navigate to System (1)
-> IP500V2 Main in the Navigation pane and select the LAN2 = LAN Settings tab in the
Details pane. Set the IP Address field to the IP address assigned to the Avaya IP Office WAN
port. Set the IP Mask field to the mask used on the public network. All other parameters should

be set according to customer requirements.

IP Offices E IP500V2 Main

&R BOOTP (9)
% Operator {3}
IPS00YZ Main

LAM Settings |VDIP | Mebwork Topolagy |

System | Lam1  LANZ |DNS | Yoicemail | Telephony | Directory Services | System Events | SMTP | SMDR. | Twinning | WCM | CCR | Codecs |

sz IPS00Y2 Main IP Address 172 . 16 . 157 . 140
B-F Line (21) IP Mask 255 . 255 . 255 . 192
[#-<= Conkral Unit (43
[+ 4 Extension (47) Primary Trans, IF Address o . o0 .0 .0
B-§  User (48) . ;
[]___;a Group (1) Firewall Profile |<N0ne> j
[+ 8% Short Code (68) RIP Made INone j
----- @ Service (0)
oy RAS (1) ™ Enable naT
[]---@ Incoming Call Route (6) -
_____ @ WanPort (0 Mumber OF DHCP IP Addresses IZDD 3.
----- ag Directory {0) DHCP Mode
£ Time: Profils (1) ’7(‘ Server ¢ Client ¢ Dialin (% Disabled advanced |

G-l Fireweall Profile (1)

On the VolIP tab in the Details pane, check the SIP Trunks Enable box to enable the

configuration of SIP trunks.

L&M Settings  WoIP |Network Topalogy I

A Hzzs Gatekeeper Enable

[ futo-create Extn ™| Auto-creats User

™| H323 Remate Extn Enable

¥ SIP Trunks Enable |

d =P Reqistrar Enable
I=| futo-creats Exknjlser

™| sIF Remate Extn Enable

Damain Mame I
¥ une LIDF Fort |5|:|50 —
Layer 4 Protocol ¥ Tce TCP Pork IEDISD 3:

™ 1is TLS Part |5|:|61 3:
|10 —]

Challenge Expiry Time (secs)

Remoke LIDP Part ISEIE-EI 3:
Remote TCP Port |5nsn 5:
Remote TLS Park ISDEul 3:
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The RTP Port Number Range can be customized to a specific range of receive ports for the
RTP media. Based on this setting, Avaya IP Office would request RTP media be sent to a UDP
port in the configurable range for calls using LAN2.

Avaya IP Office can also be configured to mark the Differentiated Services Code Point (DSCP)
in the IP header with specific values to support Quality of Services policies for both signaling
and media. The DSCP field is the value used for media and the SIG DSCP is the value used for
signaling. The specific values used for the compliance test are shown in the example below.

All other parameters should be set according to customer requirements.

LAM Settings  ¥oIP |Network Topalogy |

—RTP

— Part Mumber Range

Miniraurn |49152 3: Madirnwm |53246 3:
—Port Mumber Range (MAT)
Mirirmur |49152 3: Maxirmrm |53246 3:
¥ Enable RTCP Manitaring on Port 5005
—Keepalives
Scope IDisabIed j Periodic timeouk ID
Initial keepalives IEnabIed ﬂ
DiffSery Settings
IBS 3: DSCP{Hex) IBB 3: Widea DSCPiHex) |Fo DSCP Mask (Hex) |88 S1G DSCP (Hex)

|46 3: D3P |46 3: Yideo DSCP |63 3: DSCP Mask |34 3: 515 DSCP
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On the Network Topology tab in the Details pane, configure the following parameters:

e Select the Firewall/NAT Type from the pull-down menu to the option that matches the
network configuration. Since no network address translation (NAT) was used in the
compliance test, the parameter was set to Open Internet. With this configuration, the
STUN Server IP Address and STUN Port are not used.

e Set Binding Refresh Time (seconds) to 300. This value is used to determine the
frequency at which Avaya IP Office will send SIP OPTION messages to the service
provider.

e Set Public IP Address to the IP address that was set for LAN2.

e Under Public Port, set UDP to 5060.

e All other parameters should be set according to customer requirements.

LAM Settings | YoIF  MNefwark Topolagy |

—Metwork Topology Discovery

ATUN Server Address IG‘B.‘BD. 168,13 STLUM Part |34?8 3:

FireswallMaT Tvpe IOpen Internet j
Binding Refresh Time (seconds) 300
Public IP Address |1?2 .16 . 157 . 140 Run STUM | Cancel |
Public Port
o e

TCP

TLS

"

™ Run sTUM an skartup

In the compliance test, the LAN1 interface was used to connect the Avaya IP Office to the
enterprise site IP network. The LANL1 interface configuration is not directly relevant to the
interface with the Alestra SIP trunk, and therefore is not described in these Application Notes.
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5.3. System Telephony Settings

Navigate to the Telephony - Telephony Tab in the Details Pane. Choose the Companding
Law typical for the enterprise location. In Mexico, A-Law is used. Uncheck the Inhibit Off-
Switch Forward/Transfer box to allow call forwarding and call transfers to the PSTN via the
SIP trunk to the service provider.

B IP500V2 Main

System | LaN1 | Laniz | ONS | Voicemsil Telephony | Directory Services | System Events | SMTP | sMDR | Twinning | %cM | ccR | Codecs |

Telephony | park & Page | Tones &Music | Ring Tones | sM | callLog | TUr |

Analague Extensions Commpanding Law
Switch Ling
Default Outside Call Sequence INormaI j
Dief ault Inside Call Sequence IRing Type 1 j O UHaw € WLay line
Default Ring Back Sequence Ring Type 2 <
¥ 9 I EAEL J & A-law & A-Law Line
Restrict Analogue Extension Ringer Yoltage I

Dial Delay Time {secs) I” bS5 Status

Dial Delay Count IV Auto Hold

e
Defaulk Mo Answer Time (secs) 1 ! Dl By Hamz

v
Hold Timeout {secs) ¥ Shaw Account Code

™" Inhibit OFF-Switch F dfTransF
Patk Timeout (secs) 200 rihibi witch ForwardTransfer

" Restrict Metwark Interconnect

NENEMN

Ring Delay {secs)

- r Drop External Only Impromptu Conference
Call Priority Promation Time {secs) IDisabIed 3.

r Wisually Differentiate External Call
Defaulk Currency usD b

Default Mame Priority IFa\.-'or Trunk 'l
Media Connection Preseryvation IDisabIed Vl

r Unsupervised Analog Trunk Disconnect Handling
v High Quality Conferencing
™ Strict s1ps

v Digitalfanalogue Auto Create User

5.4. Twinning Calling Party Settings

Navigate to the Twinning tab on the Details Pane. Uncheck the Send original calling party
information for Mobile Twinning box. This will allow the Caller 1D for Twinning to be
controlled by the setting on the SIP Line (Section 5.6). This setting also impacts the Caller ID
for call forwarding.

= IP500%2 Main e v

System | Lam1 | Lamz | DNS | voicemail | Telephony | Directory Services | System Events | sMTp | smor  Twinning |vcrv| | cor | codess |

™ send ariginal caling party inFarmatian For Mabile Twinning

Calling party infarmation for I
Mahbile Twinning
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5.5. System Codecs Settings

Navigate to the Codecs tab in the Details Pane. The RFC2833 Default Payload field is new in
IP Office release 9.0. It allows the manual configuration of the payload type used on SIP calls
that are initiated by the IP Office. The default value 101 was used. The list of Available Codecs
shows all the codecs supported by the system, and those selected as usable. The Default Codec
Selection area enables the codec preference order to be configured on a system-wide basis. The
buttons between the two lists can be used to move codecs between the Unused and Selected
lists, and to change the order of the codecs in the Selected codecs list. By default, all IP (SIP and
H.323) lines and extensions will use this system default codec selection, unless configured
otherwise for a specific line or extension.

=

= IPS00V2 Main e 0 v
system | Lamt | Lanz | ows | woicemail | Telephony | Directory Services | System Events | sMTP | smbR | Twinning | vem | ccr Codecs
RFC2833 Defaulk Payload f101 ==
—dwvailable Codecs —Default Codec Selection
~Unused ————— — Selected
G711 LLAW 64K G.722 64K =o || [e 7t ALaw ek

3,711 ULAW 64K

G711 ALAW B4k 3.723.1 6K3 MP-MLQ
G.729(a) 6K CS-ACELP

G722 64K
G,729(a) 6K C5-ACELP
G.723.1 6K3 MP-MLQ

<<

S

NRAR

5.6. IP Route

Create an IP route to specify the IP address of the gateway or router where the IP Office needs to
send the packets, in order to reach the subnet where the SIP proxy is located on the Alestra
network. On the left navigation pane, right-click on IP Route. Select New (not shown).

e Set the IP Address and IP Mask of the remote subnet of the Alestra SIP Proxy.

e Set Gateway IP Address to the IP Address of the router used to reach the external
network. For the test configuration, this was the IP address of the local ISP router.

e Set Destination to LAN2 from the pull-down menu.

B 192.168.26.0 ek - X v <>

IF Route |

IP Address ftoz g8 2 0
IF Mask |255 . 255 255 . 0
Gateway IP Address |1?2 .16 . 157 . 129
Destination JLanz =]
Metric Jo =
I Prosy ARP
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5.7. Administer SIP Line

A SIP line is needed to establish the SIP connection between Avaya IP Office and the Alestra
SIP Trunking service. This line will carry outbound and inbound traffic between to and from the
service provider. The recommended method for configuring a SIP Line is to use the template
associated with these Application Notes. The template is an .xml file that can be used by IP
Office Manager to create a SIP Line. Follow the steps in Section 5.7.1 to create the SIP Line
from the template.

Some items relevant to a specific customer environment are not included in the template or may
need to be updated after the SIP Line is created. Examples include the following:

e |P addresses

SIP Credentials (if applicable)

SIP URI entries

Setting of the Use Network Topology Info field on the Transport tab.

Therefore, it is important that the SIP Line configuration be reviewed and updated if necessary
after the SIP Line is created via the template. The resulting SIP Line data can be verified against
the manual configuration shown in Sections 5.7.2 — 5.7.5.

Also, the following SIP Line settings are not supported on Basic Edition:

e SIP Line — Originator number for forwarded and twinning calls
e Transport — Second Explicit DNS Server
e SIP Credentials — Registration Required

Alternatively, a SIP Line can be created manually. To do so, right-click Line in the Navigation
Pane and select New => SIP Line. Then, follow the steps outlined in Sections 5.7.2 —5.7.6.
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5.7.1. SIP Line From Template

Complete the following steps to create a SIP Line from the template associated with these
Application Notes:

1. Copy the template file to the computer where IP Office Manager is installed. Rename the

template file to MX_Alestra_SIPTrunk.xml. The file name is important in locating the
proper template file in Step 5.

Verify that template options are enabled in IP Office Manager. In IP Office Manager,
navigate to File = Preferences. In the IP Office Manager Preferences window that
appears, select the Visual Preferences tab. Verify that the box is checked next to Enable
Template Options. Click OK.

i# 1P Office Manager Preferences

Preferences | Directories | Discovery  Yisual Preferences |Securit~;.-' | Yalidakion I

Icon Size ISmaII j
V' Multiline Tabs
V' Enable Template Cptions

il (814 | Cancel | Help

Import the template into IP Office Manager. From IP Office Manager, select Tools =
Import Templates in Manager. This action will copy the template file into the IP Office
template directory and make the template available in the IP Office Manager pull-down
menus in Step 5. The default template location where the template will be copied is
C:\Program Files\Avaya\lP Office\Manager\Templates.

ﬁ Avaya IP Office Manager IP500%2 Main [9.0.200.860] [Administrator{Administrator)]

File  Edit  “iew | Tools | Help

- EI Extension Renumber, ..

IPS00Y2 Main Line Renumber. . Main -

Conneck Ta,..
IP Offices IP500V2 Main
Export [

- & BOOTP (9)

I (7 Operator (3)
= IPS00YZ Main Busy on Held Yalidation IIF'SD':""'I2 Main
-y Swstem (1)

SCN Service User Management Yoicemail I Telephomy I Direckary Services I

ey S M3 Configuration

-4 Line (21) Print EButton Labels

Esk-<a2 Control LlniL| Import Templakes in M [pystem und ial control
@ Extension I:‘ mport Templates in Manager WSLEM Under speclal conceol
w-f User (48) L1
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In the pop-up window (not shown) that appears, select the directory where the template
file was copied in Step 1. After the import is complete, a final import status pop-up
window (not shown) will appear stating success or failure. Click OK (not shown) to
continue. If preferred, this step may be skipped if the template file is copied directly to
the IP Office template directory.

4. To create the SIP Trunk from the template, right-click on Line in the Navigation Pane,
then navigate to New - New SIP Trunk From Template.

IP Offices PRI 24 (Universal) - Line 1 i x

& BOOTP (9) PRI 24 Line |Channels|
+]-¢7 Operator (3)

IPSO0YZ Main Line Mumber IDI Line SubType IF‘RI ﬂ

Hew v Hazaune
- & cut Chrl+2 IP DECT Line IIn Service

H -

- Conf SIP Line =

- Exts A3 Copy Bifre _ ILocaI Telca j

]z = Paste Chrl+y 3M Line

388 50l % pete i SIP DECT Line
v

Yalidate Mew SIP Trunk From Template

gy RAS Conneck Ta... Chrl+T
[]---e Incq :

Mew from Template (Binary) ﬂ
.amm Dire Change Universal PRI Card Line Type b

£ Time Profile (0)
[]---@ Firewall Profile {1} Test Mumber I

-l TP Route (3] Clock Quality INetwork ﬂ Framing IESF ﬂ
----- B Arennnt Code (0N

5. In the subsequent Template Type Selection pop-up window, select Mexico from the
Country pull-down menu and select Alestra from the Service Provider pull-down menu
as shown below. These values correspond to parts of the file name created in Step 1
(MX_Alestra_SIPTrunk.xml). Click Create new SIP Trunk to finish creating the

trunk.
ﬁ Template Type Selection M =]
Locale [ Urited States (US Englsh] =l
Country I b exico j

| [T Display Al

Service Provider

Create new SIP Trunk | Cancel

6. Once the SIP Line is created, verify the configuration of the SIP Line with the
configuration shown in Sections 5.7.2 — 5.7.5.
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5.7.2. SIP Line Tab
On the SIP Line tab in the Details Pane, configure (or verify) the parameters as shown below:

e Setthe ITSP Domain Name to the domain known and expected by Alestra on the SIP
trunk. IP Office will use this domain as the host portion of the SIP URI of SIP headers in
messages sent to the network.

e Check the In Service box.

e Check the Check OOS box. With this option selected, IP Office will check the responses
to SIP OPTIONS messages sent to the service provider to determine the operational
status of the SIP Line.

e Set Call Routing Method to Request URI.

e Set Send Caller ID to None. This field determines the method to be used to send the
original calling party ID in scenarios of call forward to the PSTN and twinning. Selecting
any other option (Diversion Header, Remote party ID, etc.) made these types of calls to
be rejected by Alestra.

e Check the REFER support box. The REFER method was supported during the network
call redirection of call transfer and call forward to the PSTN.

e Default values may be used for all other parameters.

=] SIP Line - Line 17 e
a zi:r:z o(rggs) || 51P Line |Transp0rt|SIP URI|voIP | 738 Fax|SIP Credentials|
% IPSOOVZ Main Line Humber [ =
= System (1) ITSP Domain Mame [t alestravoip.com In Service I
URI Type B2 |
Prefix | Check 005 i
Mational Prefix o Call Routing Method |Request URI |
Country Cods | Fordod s o calls |
Inkernational Prefix joo Name Priaicy | System Default =l
Send Caller ID hone x| caller ID from From header |
Association Methad IBy Source IP address j Send From In Clear r
g;ea:j-:rgsent and Server |
Service Busy Response [ 486 - Busy Here |
Action an CAC Location Limit | Allow Yoicemai 4|
| | IV REFER Support
Incoring Ao |
=2 Control Unit {4) outaeing Jato =

-4y Extension (46)
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5.7.3. Transport Tab
Select the Transport tab and set the following:

e Setthe ITSP Proxy Address to the IP address of the Alestra SIP proxy server.
e Set the Layer 4 Protocol to UDP.

e Set Use Network Topology Info to LAN2 as configured in Section 5.2.

e Set the Send Port to 5060.

e Default values may be used for all other parameters.

= SIP Line - Line 17

SIF Line Transpart |SIF‘ URI|votP | 738 Fax|SIP Credentials|

ITSP Proxy Address |192.168.26.150

Metwork Configuration

Layer 4 Protocol fuop | sendport |[soen |
Use Mebwork Topology Info ILF'.N z j Listen Port ISIIIEuI:I :I
Explict DNSServer(s) |0 . 0 . 0 . 0 [0 .0 .0 .0

Calls Route via Registrar v

Separate Registrar I
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5.7.4. SIP Credentials

SIP Credentials must be created when using SIP trunk registration with the service provider

To create a SIP Credentials entry, first select the SIP Credentials tab. Click the Add button and
the New SIP Credentials area will appear at the bottom of the pane. For the compliance test, a
single SIP credential was created with the parameters shown below:

MAA; Reviewed:

Set User name and Authentication Name to the value provided by the service provider.
For the compliance test, the User name matched the DID number assigned by Alestra to

the SIP trunk.

Set Password to the value provided by the service provider.

Set the Expiry (mins) field to 60. Alestra required the registration to be renewed every
60 minutes. The registration expiration time is negotiated and agreed as part of the

registration exchange.

Check the Registration required box.

Click OK.

0
-

SIP Line -Line 17

SIP Line| Transpart| SIP URI|volP | 738 Fax SIP Credentials |

Renistration required

Index | Lsertlame | Authentication Mame | Conkack | Excpiry (mnins) | Reqgister |
— Edit 5IP Credentials
Liser name [5123456783
Authentication Mame |8123456?89
Cartact [5123456783
Fassmard I**********
Expiry (mins)

Add..,

Remowve

Edit,.,

04

Cancel

dmil
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5.7.5. SIP URI Tab

A SIP URI entry needs to be created to match each number that Avaya IP Office and Alestra will
accept on this line. Select the SIP URI tab, click the Add button and the New Channel area will
appear at the bottom of the pane. To edit an existing entry, click an entry in the list at the top, and
click the Edit... button. In the example screen below, a previously configured entry is edited.

For the compliance test, a single SIP URI entry was created that matched the DID number
assigned to the SIP trunk by Alestra. The entry was created with the parameters shown below:

e Set Local URI, Contact and Display Name to Use Credentials User Name. Set PAI to
None.

e Under Registration, select 1: <8123456789> from the pull-down menu, which
corresponds to the set of SIP credentials defined in the previous section.

e Associate this line with an incoming line group by entering a line group number in the
Incoming Group field. This line group number will be used in defining incoming call
routes for this line. Similarly, associate the line to an outgoing line group using the
Outgoing Group field. The outgoing line group number is used in defining short codes
for routing outbound traffic to this line. For the compliance test, a new incoming and
outgoing group 17 was defined that only contains this line (line 17).

e Set Max Calls per Channel to the number of simultaneous calls to be allowed on the SIP
trunk using this SIP URI pattern.

= SIP Line - Line 17

SIP Line | Transport SIP URI |'u'|:|IP | 738 Fax| 5P Credentials |

I Yia I Lacal URT I Cantack I Display Mame I FAT I Cre
g1234.., 8123, 5123456789 N.., 1if

Add,
Remowve |
Edit... |

Channel I Graups
1 17 17 1.

— Edit Channel
[0]4 |

ia |1?2.16.15?.14D

= - Cancel |
Local LRI lse Credentials User Mame
Cantack |Use Credentials User Mame j
Display Mame IUse Credentials User Mame j
Pal frone -]
Registration f1: 8123456789 |
Incoming Group IlT-"
Qukgoing Group Il?
Maz Calls per Channel |1E| 5:

MAA; Reviewed:
SPOC 8/7/2014

Solution & Interoperability Test Lab Application Notes

©2014 Avaya Inc. All Rights Reserved.

20 of 31
Altr_Brsft_IPO9



5.7.6. VolP Tab

Select the VolIP tab to set the VVoice over Internet Protocol parameters of the SIP line. Set the
parameters as shown below:

X
o

Locakion

In the sample configuration, the Codec Selection was configured using the Custom
option, allowing an explicit ordered list of codecs to be specified. The buttons allow
setting the specific order of preference for the codecs to be used on the line, as shown.
Set Fax Transport Support to T38.

Set the DTMF Support field to RFC2833. This directs Avaya IP Office to send DTMF
tones using RTP events messages as defined in RFC2833.

Check the Re-invite Supported box to allow for codec re-negotiation in cases where the
target of an incoming call or transfer does not support the codec originally negotiated on
the trunk.

Check the PRACK/100rel Supported box, to advertise the support for provisional
responses and Early Media to Alestra.

Default values may be used for all other parameters.

SIP Line - Line 17

SIP Line| Transport| STP LRI YoIP 138 Fax| STP Credentials|

[ woIP Silence SuUppression

™| allow Direct Media Path

Codec Selection Custom -
I J ¥ Re-invite Supparted
—Unused ————— —Selected r
5722 64K - G.720a) 8K C5-ACELP Codec Lockdown

G711 ALAW 64K
G711 LLAW &4k

5.723.1 BK3 MP-MLG ¥ PRACK[100rel Supported

™ Force direct media with phones

o T 5711 Fax ECAN

LR

S

Fax Transport Suppork |T38 j

ICIaud j

Call Initiation Timeouk {s) |4 3:

DTMF Suppart [RFC2833 =]

Since default values were used for all settings on the T38 Fax tab, this screen will not be visited.
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5.8. Incoming Call Route
Incoming call routes map inbound DID numbers on a specific line to internal extensions, hunt

groups, short codes, etc, within the IP Office system. Incoming call routes are defined for each
DID number assigned by the service provider.

To add a new incoming call route, from the left Navigation Pane, right-click on Incoming Call
Route and select New (not shown). The screen below shows the route for the DID number
assigned to the enterprise by Alestra, 8123456789 in this example.

On the Details Pane, under the Standard tab, set the parameters as show below:

e Set Bearer Capacity to Any Voice.

Set the Line Group Id to the incoming line group of the SIP line defined in Section 5.7.
Set the Incoming Number to the 10 digit DID number assigned by Alestra.

Default values may be used for all other parameters.

=
IP Offices = 17 8123456789
---ﬂ BOCTP (9} Standard |\-'|:uice Recording | Destinations |
----- i+ Operator (3)
- IPS00YZ Main
Syskem (1) Bearer Capability I.f\nv ‘oice j
-y IPSOOYE Main _
'T_‘u Line (213 Lire Group 10 Il? j
v Contral Unit (4) ‘e ey |8123456?89
@* Extension (46)
g User (48) Incoming Sub Address I
aa Group (1) _
“ Shart Code (68) Incoming CLI I
@ Service (0] Locale I j
- alfy RAS (1)
EI@ Incoming Call Route (6] Priarity |1 - Low j
e 21 Tag I
168
g o Hold Music Source IS';-'stem Source ﬂ
e 0 Ring Tone Owverride INDI'IE j
f?ﬂ “WanPort (00

On the Destinations tab, select the destination extension from the pull-down menu of the
Destination field. Click the OK button (not shown). In this example, incoming calls to DID
8123456789 on line 17 are routed to hunt group 2000 Main.

17 8123456789 : Xl v|<|s>

Standardl Woice Recording  Destinations |

TimeProfile Destination Fallback Extension
P |Defauk value 2000 Main =l hd|
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5.9. Short Code

Define a short code to route outbound traffic to the SIP line. To create a short code, right-click
on Short Code in the Navigation Pane and select New (not shown). On the Short Code tab in
the Details Pane, configure the parameters as shown below.

e Inthe Code field, enter the dial string which will trigger this short code, followed by a
semi-colon. In this case, 8N;. This short code will be invoked when the user dials 8
followed by any number.

e Set Feature to Dial. This is the action that the short code will perform.

e Set Telephone Number to N”@asbw.alestravoip.com”. This field is used to construct
the Request URI and To headers in the outgoing SIP INVITE message. The value N
represents the number dialed by the user.

e Setthe Line Group Id to the outgoing line group number defined on the SIP URI tab on
the SIP Line in Section 5.7. This short code will use this line group when placing
outbound calls.

e Default values may be used for all other parameters.

IP Offices B 8N;: Dial
(=) IPSO0V2 Main || short code |
-5 System (1)
ey IPSOOYZ Main Code ISNJ
-4 Line (21) -
f#l-== Cantral Unit (4) Feature |Dial =l
[H-4 Extension (46) Telephone Murber IN"@asbw.alestravoip.cnm"
- User (48)
[]—--# Group (1) Line &roup ID I5Dl fain j
=&+ short Code (630
L@ 00 Liocale IUnited States (115 English) ﬂ
""" :" :Dl Force Account Code [
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5.10. Automatic Route Selection

Optionally, Automatic Route Selection (ARS) can be used rather than the simple short code
approach described above. With ARS, secondary dial tone can be provided after the access code.
Other features like time-based routing criteria and alternate routing can be specified so that a call
can re-route automatically if the primary route or outgoing line group is not available. ARS also
facilitates a more granular treatment for different types of calls, and permits a more specific
matching of the telephone number dialed following the access code. While detailed coverage of
ARS is beyond the scope of these Application Notes, and alternate routing was not used in the
reference configuration, this section includes some basic screen illustrations of the ARS settings
used during the compliance test.

To create a short code to be used for ARS, right-click on Short Code in the Navigation Pane and
select New (not shown). The screen below shows the short code 9N created. Note that the semi-
colon is not used here. In this case, when the Avaya IP Office user dials 9 plus any number N,
instead of being directed to a specific Line Group ID, the call is directed to Line Group 50:
Main, which is configurable via ARS.

= 9N: Dial

Short Code |
Code |9N
Feature IDiaI j

Telephone Mumber IN

Line Group IC IEEI: Main j

Locale ILIniteu:I Skates (105 English) j

Force Account Code [
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The following screen shows the example ARS configuration for the route Main. Note the
sequence of Xs used in the Code column of the entries to specify the exact number of digits to be
expected, following the access code and the first digit on the string. This type of setting results in
a much quicker response in the delivery of the call by the IP Office. For example, for local calls,
the user dialed 9 plus the 8 digit local number, starting with a 1 or a 2, which was the range of

local numbers used during the compliance test. For national long distance calls in Mexico, the

user dialed 9, then 01, followed by 10 digit numbers.

IP Offices Ei Main® ef - X v <
- & BOOTP (39 AR5 |
o) Operator (3)
) IPS00Y2 Main ARS Route Id |50 v Secondaty Dial tone
27 System (1)
Lty IPSO0YZ Main Route Name IMaln— ISystemTone j
BT Line (21)
B Contral Linit (4) Dial Delay Time ISystem Default (4) 3: IV Check User Call Barring
[+--48 Extension (46)
E-f User (48)
155§ Group (1) In Service v Qut of Service Route |<None> j
[+-@% Short Code (63)
----- @ Service (0) l
[F-adfy RAS(1)
[]---e Incoming Call Route (6| Time Praofile «Mang = | ey O 0F Hours Route |<None> j
----- H8 wanPart (0)
atm Directory (00 l
g".1\ Tirne Profile (03 -
[]___® Firewall Profile {13 Code | Telephane Murber | Feature | Line Group ID il Add... |
-l 1P Rauts (3) 411 411 Dial 17
..... B Account Code (0) [z 2 Dial 17 ] Remove |
..... W License (62) 040 040 Dial 17 J —
..... W Tunnel (0) Ol 01N Dial 17 ] 4|'
-§y User Rights (83 01 SO0 01800M Dial 17
E-" g AR5 (2) [IIEtEEEEE S 0ar Dial 17
(50 Main N S nnir Nial 17 _ILI
¥ 51: Qutbound Fax 1 | B
----- 4 RAS Location Request 1
----- 5 Location (00
Alternate Route Priority Lewvel |3 'l l
Alternate Route Wait Time ISD 3: et fi|LEF IS RiOUEE: |<N0ne> j
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5.11. Save Configuration

Navigate to File > Save Configuration in the menu bar at the top left of the screen to save the
configuration performed in the preceding sections.

The following will appear, with either Merge or Immediate selected, based on the nature of the
configuration changes made since the last save. Note that clicking OK may cause a service
disruption. Click OK to proceed.

Save Configuration M= E3

— IP Office Settings

IP300YZ Main

— Configuration Reboot Mode
i+ Merge

" Immediate

" when Free

' Timed

— Rebook Time

14:53 =

— Call Barring
El Incoming Calls
E Dukgaing Zalls

K, I Cancel Help
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6. Alestra Enlace IP SIP Trunking Configuration

Alestra is responsible for the configuration of the Alestra Enlace IP SIP Trunk service. The
customer will need to provide the IP address used to reach the Avaya IP Office at the enterprise.
Alestra will provide the customer the necessary information to configure the Avaya IP Office
SIP trunk connection, including:

IP address of the Alestra SIP Proxy server.

Credentials for the SIP trunk registration.

Supported codecs and order of preference.

DID numbers.

All IP addresses and port numbers used for signaling or media that will need access to the
enterprise network through any security devices.

7. Verification Steps

The Avaya IP Office System Status and Monitor applications are useful tools used for the
verification of the IP Office configuration and for troubleshooting the SIP connection to the
service provider.

7.1. System Status

The Avaya IP Office System Status application can be used to verify the service state of the SIP
line. Launch the application from Start = Programs => IP Office = System Status on the PC
where IP Office Manager was installed. Under Control Unit IP Address select the IP address of
the IP Office system under verification. Log in using the appropriate credentials

Online [ offline

Logon

Control Unit IP Address: EEEESRT RN

Services Base TCP Port: ik

Local IP Address: E:1GInt-le

User Name:
Password:

ﬂ Auto reconnect
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Select the SIP line of interest from the left pane (Line 17 in the reference configuration). On the
Status tab in the right pane, verify that the Current State is Idle for each channel (assuming no
active calls at present time).

Avaya IP Office System Status - IP500¥2 Main (192.168.10.60) - IP500 ¥2 9.0.2.0 build 860 |_ (O] x

IP Office System Status

Help Snapshob  LogOff Exit  About

System

& Alarms (13) Ll Alarms  Registratio
Extensions (27) SIP Trunk Summary
Trunks (5)
Peer Domain Name: ashbw, alestravoip.com
Resolved Address: 192,168 .26.150
Line Mumber: 17
Number of Administered Channels: 10
Active Calls Number of Channels in Uise: i}
Resources Administered Compression: G729 A, G711 A, G711 My
Yoicemail Silence Suppression: OFF
IF llet_wnrking Laver 4 Protacal: uppP
Locations SIP Trunk Channel Licenses: Unlimited . 0%
SIP Trunk Channel Licenses in Use: ]
SIP Device Features: REFER. {Incoming and ©ukgaing), UPDATE {Incoming and Cutgoing)
Round
Trip De... Ji
1 Idle 00:00:26
2 Idle 00;00;40
3 Idle  |Sdays..
4 Idle |6davs...
5 Idle  |6days..
] Idle |6days...
7 Idle |6days..
g Idle |6davs...
9 Idle |6days...
10 Ide |Gdays..

e Select the Alarms tab and verify that no alarms are active on the SIP line.

Avaya IP Office System Status - IP500¥2 Main (192.168.10.60) - IP500 ¥2 9.0.2.0 build 860

IP Office System Status

Help Exit  About

System

& Alarms (13) Status  Ukilizal Summary Alarms Reqistration

Extensions (27) Alarms for Line: 17 SIP asbw.alestravoip.com

Trunks (5}
Line: 1

QCEUrrences Etror Description

IP Office System Status

System . .
& Alarms (13} Status  Utilization Summary Alatms | Registration

Extensions (27} Registration Status
Trunks (5}
Line: 1

User Marns Retry Time

8123456789 Registered Bi23{2014 11:10:32 AM
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7.2. Monitor

The Avaya IP Office Monitor application can be used to monitor and troubleshoot signaling
messaging on the SIP trunk. Launch the application from Start = Programs = IP Office -
Monitor on the PC where IP Office Manager was installed. Click the Select Unit icon on the
taskbar and Select the IP address of the IP Office system under verification.

Iﬂ_ Avaya IP Office SysMonitor - [STOPPED]
File Edit Wiew Fikers Status Help

=8| »8|T| x|V = €<=

' RN

Start/Stop Trace Select
Trace Options  Unit

Clicking the Trace Options icon on the taskbar and selecting the SIP tab allows modifying the
threshold used for capturing events, types of packets to be captured, filters, etc. Additionally, the
color used to represent the packets in the trace can be customized by right clicking on the type of
packet and selecting to the desired color.

atM | cal | DTE | ECont | FrameRelsy | GOD | H323 | Intesface |
T1 | VPN | WAl | SCN ] Jade
ISOH ] K.w.ﬂ.-un‘pl Dilel::h:lr:,'] Media | PPP | A2 I Hl:luling] Servicez Ej.'slem
Everts
¥ Sip [Low = ™ STUN ™ SIP Dect
Packets
[~ SIP Reg/Opt Rx [~ SIP Misc Rx
[~ SIP Reg/Opt Tx [~ SIP Mise Tx
¥ SIP Call Fx ™ CmMotily Ry
W SIPCal Ty ™ Con Nty T
¥ Sip Ax [~ hes IF Fiter [man.ninm nrn e
¥ Sip Tx [ hex |
Defouk All | Cloar Al | TabClesrat | Tabseran oK Cancel
Save Fie J LoadFie |  SelectFie J
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8. Conclusion

These Application Notes describe the procedures for configuring Session Initiation Protocol
(SIP) Trunking between the Alestra Enlace IP SIP Trunk service on the Broadsoft platform and
Avaya IP Office 9.0, using SIP Trunk Registration, as shown in Figure 1.

Interoperability testing of the sample configuration was completed with successful results for all
test cases with the exception of the observations/limitations described in Section 2.2.
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Product documentation for Avaya products may be found at http://support.avaya.com.
Product documentation for the Alestra Enlace IP SIP Trunk Service is available from Alestra.
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